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1. Introduction

Use the Control4® Composer Media Edition (Composer ME) application to set up your media and
playlists and perform other tasks related to your music, movies, and videos.

1.1 Purpose

The purpose of this document is to give you instructions, examples, and tips about how to add and
manage the media for your Control4 system. This document applies to the Control4 Operating System
2.2.4 (0S 2.2.4).

Words that appear in red are either in the Glossary or provide tips, examples, and other important
information.

1.2 Related Documents and Resources

Document file name Title and location

Control4 System Quick | PDF: http://www.control4.com/residential/products/resources/
Start Guide (200-00153)

Control4 System User PDF or Help: http://www.control4.com/residential/products/resources/
Guide (200-00001)

Control4 Composer Help: Composer HE application
Home Edition Getting PDF: http://www.control4.com/residential/products/resources/
Started

(200-00169)

Control4 Composer PDF or Help: http://www.control4.com/residential/products/resources/
Home Edition User
Guide (200-00170)

Control4 System PDF only: http://www.control4.com/residential/products/resources/
Remote Control SR-
250 User Guide
(200-00152)

Control4 MyHome PDF: http://www.control4.com/residential/products/resources/
Setup Guide for
Homeowners (DOC-
00004)
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1.3 What's New in This Release?

The Control4® Composer Media Edition (Composer ME) software and hardware updates for OS 2.2.4
and earlier are detailed below.

131 0S 224

Added support for a new Door Station — Interior product (C4-DCS-EN-INT).

Added support for a new line of Sony STR-DA2800ES/DA5800ES receivers.

e ZSO-STRDAS800ES (Sony STR-DA5800ES AV Receiver)

e ZSO-STRDA5800ES-C4 (Sony STR-DA5800ES with Full Control4 Automation)
e ZSO-STRDA2800ES (Sony STR-DA2800ES AV Receiver)

e ZSO-STRDA2800ES-C4 (Sony STR-DA2800ES with Full Control4 Automation)
e (C4-SO-STR-Activation (Control4 Activation License)

132 0S221

Added support for the new 7" In-Wall Touch Screen with Camera (C4-TW7CO-BL).
Added support for the new HC-250 Controller (C4-HC250-BL).
Added support for the new Door Station — Exterior (C4-DSC-EN-xx).

Added new HC-250 Controller, Door Station — Exterior, and 7" In-Wall Touch Screen with
Camera references to "Getting Started."

Updated some examples.

133 0S 22

A new 7" Portable Touch Screen with Camera has been added to the product line with audio
and video Intercom capabilities. See the Control4 System User Guide for details about
Intercom.

Minor changes were also made to the Disc Changer and CD sections.
Added support for MyHome® — Android. See the Control4 System User Guide for details.
This document contains minor edits only.

134 0S21

1.3.4.1 New Hardware and Media Support

Added the Apps container to the default Control4 home page; 4Store is now in the Apps
container. This means that there are currently seven (7) containers on the fully-populated
default Control4 Home page (Watch, Listen, Lights, Security, Comfort, Apps, and More).

When there is only a single Thermostat in the project, selecting Comfort from the Home page
automatically loads the Thermostat control UI.

Added the ability to turn off the Ambient Light Sensor on the SR-250 (V2) from the remote’s
LCD menu.

Added a new 4Store agent.
Added the ability to create custom buttons for the Navigator screens.

Copyright © 2012 Control4. All Rights Reserved.
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Photo Screen Saver agent can now serve a single image on all connected graphical
Navigators.

MyHome apps now supported for mobile and PC/Tablet devices. See Control4 MyHome
Setup Guide or Control4 System Quick Start Guide for detalils.

Support for Internet radio.

1.3.4.2 New or Updated Sections

Added the ability to change visibility and display the order of Thermostats (System Design >
Properties > Navigator.

You can now hide the Thermostat as other Navigator devices through Composer menu
settings.

Replaced most screens with new Control4 logos.
Added a new “Setting Up Internet Radio” section.

1.3.4.3 Hardware and Software No Longer Supported or Partially Supported

No update is provided for legacy Navigators (Mini Touch Screen, 10.5” Wireless Touch
Screen V1, 10.5" In-Wall Touch Screen). These devices will continue to work in compatibility
mode.

Mobile Navigator has been replaced by MyHome apps.

After OS 2.0.6, no update will be provided for the POE LCD Keypad.

The Wireless LCD Keypad and WiFi Mini Touch Screen are no longer supported.
The Sony Component Video Switcher is no longer supported.

135 0S 205
Highlights:

Support for HC-200B as a Primary Controller (functionality included in software update)
New logos

1.36 0S20
Highlights:

New Navigator interface

Improved media management and performance
ZigBee Pro implementation for the broader market
New or updated documentation for homeowners

1.3.6.1 New Media and Hardware Support

A new Flash interface has replaced the interface in Release 1.8.x and earlier. This interface
appears on all of the graphical Navigators (Touch Screens and On-Screen Navigators) that
OS 2.0 supports. The Control4 System Quick Start Guide and Control4 System User Guide
for OS 2.0 explain how to use this new interface.

A new Control4 4Store™ has been added for the Navigators. Customers can purchase
applications from the Web for the Touch Screens and On-Screen Navigators in their Control4
system.

Media menu. New option 'Tag media files.'

Copyright © 2012 Control4. All Rights Reserved.
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A new IO Extender has been added to the Control4 product line.

A new Home Controller HC-1000 V3 has been added to the product line.
Support for AAC and WMA music formats.

New robust media online lookup service (Gracenote®) that replaces AMG.

1.3.6.2 New or Updated Sections

The Composer and Composer-related documents have been updated and restructured for
Control4 OS 2.0 to make it easier for you to get the information you need more quickly. Most
topics in this document are available in the online Help (application), WebHelp, or PDF on the
Control4 web site.

All sections in this document have been restructured, reordered, and enhanced.

e New links, bread crumbs and Glossary pop-ups have been added to the topics in the
online help.

e Text has been pared down for ease of use and readability.

1.3.6.3 Hardware and Software No Longer Supported or Partially Supported

Home Theater Controller (functions as a Secondary Controller, but not as a Primary
Controller; On-Screen Navigator continues to use the legacy interface — prior to OS 2.0).

Media Controller (functions as a Secondary Controller, but not as a Primary Controller; On-
Screen Navigator continues to use the legacy interface — prior to OS 2.0).

Home Controller HC-1000 V1 (no longer sold by Control4 but fully supported with OS 2.0).
Home Controller HC-500 (no longer sold by Control4 but fully supported with OS 2.0).

10" Wall Mount Touch Screen (will be updated to OS 2.0 but continues to use the Navigators
— prior to OS 2.0. This is the last planned update for this device; future support will be limited
to compatibility mode).

10.5" Wireless Touch Screen V1 (will be updated to OS 2.0 but continues to use the
Navigators — prior to OS 2.0. This is the last planned update for this device; future support
will be limited to compatibility mode).

Mini Touch Screen V1 and V2 (will be updated to OS 2.0 but continues to use the Navigators
— prior to OS 2.0. This is the last planned update for this device; future support will be limited
to compatibility mode).

System Remote Control V1 and V2 (will need to be replaced if used with OS 2.0).
Contact Relay Extender (does not support ZigBee Pro). Use an IP connection for OS 2.0.
Audio products (do not support ZigBee Pro). Use an IP connection for OS 2.0.

Easy Setup.

Easy Importer.

The AMG lookup service has been changed to Gracenote®. The Sony 777 Disc Changer
uses Gracenote, but the Media Controller can no longer access album, title, or artist
information from AMG. CDs, however, can be imported and will show up in the Media
database with a date and time stamp.

USB Restore or USB Install. Because an Internet connection is required, these USB utilities
are not supported in OS 2.0. Use the 1.7.x or 1.8.2 versions of these utilities. After a restore,
you can update to OS 2.0 from 1.7.4 and 1.8.2 to OS 2.0.

Copyright © 2012 Control4. All Rights Reserved.
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e Other Media Managers: You can use other media managers, for example, iTunes, Windows
Media player, and Media Monkey to create MP3s. You can still use Composer ME and
Composer HE to add files to Control4.

e Web Navigator. Rhapsody and 4Store cannot be accessed from the Web Navigator. Use the
Touch Screens or On-Screen Navigators.

1.3.6.4 Hardware that Doesn’t Support ZigBee Pro

e Control4 System Remote Control, V1 and V2. Use a newer version that supports OS 2.0.

e Audio products: Amps, Switches, Tuners, Speaker Point, etc. Use an IP connection for OS
2.0.

e Contact Relay Extender. Use an IP connection for OS 2.0.

Getting Started

Control4® Composer Media Edition (Composer ME) is the software you use to add, scan media, edit
media information, and create playlists in the Control4 system for use with the Control4 Navigators.
Using a Windows XP-based PC, this program uses a drag-and-drop interface and runs on the
Control4 Operating System (OS) Release 2.0 (OS 2.0) and later.

The brains of the Control4 system are the Control4 Controller (for example, HC-800 Controller). The
Controller communicates with Control4 and third-party products to enable home automation and
interaction of Control4-controlled devices.

Notes: (1) The term 'Controller' referenced in this document refers to any Control4 product that
contains the Director component, such as Home Controller HC-1000 V3. Director is the software that
controls the system. (2) The new Sony STR-DA2800ES with Full Control4 Automation or Sony STR-
DABB00ES with Full Control4 Automation use Director also.

2.1 Requirements
Control4® Composer ME requires that your system is functioning correctly before attempting to use
this software (OS 2.2.4 and later). Talk to your Control4 Dealer if this product does not function as
documented; this may indicate that the Conrol4 system may not be set up properly.
Software and network requirements for using Composer ME:
e Control4 Controller (such as HC-800 Controller). Note: The Media Controller and Home
Theater Controller are not supported in OS 2.0 and later as the Primary Controllers
(Secondary Controllers only).
e PC to run the Composer ME software and control the devices.
e Composer ME (launches Microsoft .NET 1.1 web install).
e Microsoft Windows XP and Service Pack 3 (Home or Professional), Windows Vista, or
Windows 7.
e 500 Mhz processor or higher.
e 256 MB RAM.
e 80 MB hard disk space.
e Video card and monitor supporting resolution of 1024 x 768 or higher.
Copyright © 2012 Control4. All Rights Reserved.
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e Keyboard.
e Mouse.

e TCP/IP-based home network (DSL/cable modem, Control4 secure gateway, router, or switch)
to connect the PC to the Controller.

¢ Internet Connection (broadband required for retrieving cover art and media information).

e Registration at my.control4.com is required. See your Control4 Dealer or the Control4 System
Quick Start Guide for details.

Installing Composer ME

Follow the steps below to install the Control4® Composer ME software.

Prerequisites

Ensure that you understand the software and network requirements to use this product. Your Control4
Dealer or Installer can assist you if needed.

To install Composer ME:

1. Start the Composer ME installation and follow the on-screen instructions. You might be asked for
a registration key. If so, check with your Control4 Installer or Dealer for details.

2. If prompted to update, follow the on-screen instructions to update to the latest version of
Composer ME.

The Composer ME software and device drivers may have been updated when the CD or web
download was created. Control4 recommends, however, that you always choose to update.

Starting Composer ME

When you start Composer ME, you must connect to Director on your home network.

Prerequisites

Ensure that you have installed Composer ME and registered on my.control4.com. You may want to
sign up for and use Rhapsody® also (a subscription-based music service). See the website for your
service to learn how to run the music service in the Control4 system.

To start Composer ME:
1. From the desktop, double-click the Composer ME icon.
2. Atthe Composer ME startup screen, click Director on Local Network.

Copyright © 2012 Control4. All Rights Reserved.
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Composer

Connect to:

Virtual Director Director on Remote Director
Local Network

s Control @ ”

Note: Even though the Virtual Director and Remote Director show on the Startup screen, they are not
available in Composer ME and are grayed out.

3. From the Directors dialog, select the Director’s address of the Controller you are setting up.

Marme Address b Connect
Steph il it 1

gpeterson-desktop i1 11 =8
wirz-test-contraller- 1 e me i1 L |

DranzDeskHCTO000-0800 e i i1t i

horme-controller-1 008000 i1 i

rnattzandHC-T000-0000 0w s i1 111

home-controller-1008 mEE i1 Fuleh

WSPOA-PROD-182 mme= 1 i Add...
home-controller- 300 mREss i1 42k ot

W ebD ewHCI00-0008 55w i1 IRE =t Remove
horme-controller-5000 mREss i1 brighal,

hu:_ulme-cu:untrculller"-:ZEIFEI" R i1 i il F

Tip: If the Director’s address does not appear immediately, click the Refresh button. If it still does not
appear, contact your Control4 Dealer.

4. Click Connect.
5. Composer opens to the main Composer ME interface.

Copyright © 2012 Control4. All Rights Reserved.
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Refreshing the Navigators

Use the Control4® Composer ME menu bar to refresh your Touch Screens, On-Screen Navigators,
MyHome apps, and System Remote Control whenever you make changes to Composer.

Prerequisites

Ensure that the Navigators are added and identified to the Control4 system. Your Control4 Dealer or
Installer can help you.

To refresh the Navigators:

In case your Navigators do not automatically refresh after you've made changes to Composer ME,
from the menu bar, choose File > Refresh Navigators.

Tip: New media shows up automatically in the Navigators unless your device is disconnected or has
changed locations. In this case, you may need to identify the device again.

Refer to the Control4 System User Guide to test your Navigator features.

Closing Composer ME

Use the Control4® Composer ME File > Exit or Exit Composer options to close the application.

Before Composer ME exits, the application asks you if you want to back up your project. It is always
good practice to do so.

Saved: 8/29/2012 9:50:00 AM
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The Control4®Composer ME interface lets you:

e Add and scan media to your Controller (for example, Home Controller HC-500, HC-800, or
HC-1000 Controllers).

e Create playlists of MP3, AAC, FLAC, or WMA files saved on your Controller’s hard drive in

the Media Database (requires a HC-1000 Controller).

Prerequisites

Ensure that Composer ME has been installed.

To use Composer ME:
1. Start Composer ME.

2. Connect to the Director on Local Network. (See “Director's Dialog” section below.)

3. View the Media pane (see below).

Composer ME interface:

£ oWl acy Livening
g ye—
L weRlTS_lazs
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L gweRDE_Couiry MPA [Videt) b

Directos Statur Ide

| Connected

When you add or scan media (Media Scanning Options), you can then view and select the stored/
broadcast media and playlists from the Touch Screens or On-Screen Navigators: TV monitor, Touch

Screens, MyHome apps, and System Remote Control (in List format).

Saved: 8/29/2012 9:50:00 AM
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3.1 Directors Dialog

After you start the Control4® Composer ME application, the following dialog appears; you need to use
the Controller's network address to connect to the Director.

Directors Dialog:

Directors

Mame Address -~ Connect
Steph i i
gpeterson-desktop i { Cancel
wirz-test-contraller- 1 e f it il

DranzDeskHCT1O000-0800 8 f fi Jrin

home-contraller-100F 00w i fl

mattzandHC-1 000000 0wl | f

home-controller-1008 mEE | It f

WSPOA-PROD 182 mmwss f f Add...
home-controller-300 mREss i {25 dil

WwhiebDewHC00-000e = s f f

home-controller-5000 mREss

home-controller- 2000 mmEss | f il 3 Flefresh

P ol WOl | WPl | o o o - e

IIT@T

Connecting to a Director on the home network lets you set up your media cover art and metadata on
your Controller so it is viewable on the Touch Screens, MyHome apps, or On-Screen Navigators.
Each Director has an associated address.

Director's Dialog buttons:

Connect. Connect to the Director on your Controller.
Cancel. Cancel and close the Director dialog.

Add. Launch a dialog that lets you add the Director’s address of the Controller to which you
are trying to connect.

Remove. Lets you remove a Director.
Refresh. Update the Director list to display the recently added Directors.

3.2 Media View

Use the Control4® Composer ME Media view to add or scan your media.

Media view (same view as the main screen after startup):

Copyright © 2012 Control4. All Rights Reserved.
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There are two (2) types of media that can be added or scanned in a Control4 system:
1. Stored Media
2. Broadcast Media

The other two (2) categories are to scan media and manage playlists.

Note: The AMG lookup service has been switched to Gracenote®. The Sony 777 Disc Changer uses
Gracenote, but the Media Controller cannot access album, title, or artist information from AMG. CDs,
however, can be imported and will show up in the Media database with a date and time stamp.

Other Media Managers: You can use other media managers, for example, iTunes, Windows Media
player, and MediaMonkey to create MP3s. You can still use Composer ME to add files to the Control4
system.

3.2.1 Stored Media
Media types supported:

e CD. Store CD selections and view the Cover Art, Album, Artist, and Genre type (such as
Rock or Country).

e DVD or Disc Changer. Store DVD and CD selections and view the Cover Art, Title, Info,
Results, Media, and Disc List.

e Digital Audio Player. Store MP3, HDD, AAC, or FLAC music selections and view the Cover
Art, Album, Artist, and Genre type (such as Rock or Country) on a Home Controller HC-1000
V3 hard disk or other digital audio player.

e Network File Storage. Store MP3, HDD, AAC, or FLAC music selections and view the Cover
Art, Album, Artist, and Genre type (such as Rock or Country) on a hard disk attached to the
network or a USB drive.
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3.2.2 Broadcast Media

Media types supported:
e Direct TV. View Direct TV channel options including Station ID, Genre, and Music Channel.

o Dish Network. View Dish Network channel options including Station ID, Genre, Rating, and
Music Channel.

e Cable TV. View Cable channel options, including Station ID, Genre, Rating, Music, and
Channel.

e UHF/VHF. View UHF channel options including Station ID, Genre, Rating, and HDTV.
e AM/FM/XM. Scan AM, FM, and XM stations.
e Internet radio. Set up Internet radio stations.

3.3 Menu Options
Control4® Composer ME menu options:

e File menu. Connect to the Director on your home network, refresh Navigator devices with
new media information, or exit Composer ME.

e Media menu. Create a new playlist, or clear, export, and import media lists. See “Media
Menu” below.

e Help menu. View the Composer ME online Help and software version.

3.3.1 File

The File menu lets you perform project file management tasks, connect to Director, start Interviewer,
and refresh Composer ME and the Navigators, including Touch Screens, MyHome apps (if they are
online), and On-Screen Navigators. The file management options relate to the Composer ME project
files you back up on your PC (they have a .c4p extension). Project files always save by default to the
'My Documents' directory.

When you set up a Control4 system, you create live project configuration information on the Controller
that is backed up to a project file on your PC. This lists specific information about each system,
including devices, connections, configuration, programming information, and media.

e Connect to Director. Connects you to the Director residing on the Controller. When you
connect, project configuration information from the Controller is displayed on the Composer
ME screen.

e Disconnect from Director. Disconnects you from the Director. Composer ME prompts you
to back up your project before disconnecting you from the currently-connected Director. This
option is available when connected to the Director.

o Refresh. Refreshes the Composer ME screen with the current information from Director.

o Refresh Navigators. Refreshes the Navigators with the latest information from Director.
Note: MyHome for PCs and tablets must be updated in that app. MyHome for iPhone, iPod
touch, iPads, and Androids will update if online.

e Exit. Exits Composer. Composer ME prompts you to back up your project prior to exiting the
software and returning to the desktop. Control4 recommends that you always back up your
project before you exit.
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3.3.2 Media

From the Media menu, the media either has been scanned or manually added to the Media Database.
After an item is added to the Media Database, the cover art and metadata about the media is
viewable and selectable from any of the Navigators.

Tip: Control4 recommends that you use the Export Media List (see below) feature which lists of all
your media saved to the hard drive on your PC.

The following options are available:

3.3.3 Help

Clear Media List. Clears the media list associated with the highlighted device from the Media
Database.

Export Media List. Exports a media list for the selected device from your Controller to your
PC.

Import Media List. Imports a media list from your PC to your Controller.

Export Playlists. Exports a playlist from your Controller to your PC.

Import Playlists. Imports a playlist from your PC to your Controller.

Import DVD List from File. Imports a Microsoft Excel list of DVD titles for a Disc Changer.

New Playlist. Creates a playlist of MP3, AAC, or FLAC files. The playlist is available from
any Touch Screen or On-Screen Navigator. Add albums, remove songs, re-order songs, etc.
Note: If you remove songs from a playlist, it does not remove them from the Media Database.

Delete Playlist. Removes a playlist.
Rename Playlist. Renames a playlist.

Tag media files. Used for OS 2.0 conversion of media files so all media players can see the
same tags.

From the Help menu, you can access the online help of this Composer ME User Guide with Index,
Glossary, and Search options, or check the version of your Composer software and Director
component.
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4.  Setting Up Media and Playlists

Before you can view and select your media from the Control4®Navigators, the Control4 system needs
to be able to recognize it. So you first need to add and scan your media to the Controller using the
Composer ME Media view. See “Auto-Scan Media in Composer ME” in this document.
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To add and scan songs and albums for playlists, they must be available in MP3, AAC, or FLAC format
on a PC, Controller, or network share. With the MP3, AAC, or FLAC files you add and scan, you can
create playlists and save them either to the Controller’s hard drive or a network storage drive.

Tip: Composer ME requires that your system is functioning correctly before using your media. For
example, if you have a Disc Changer that does not appear in the left pane of the Media view, there's
no Disc Changer in the system to add media to it. Contact your Control4 Dealer if this is the case.

Prerequisites

Ensure that the appropriate devices have been added and identified to your Control4 system. Your
Control4 Dealer or Installer can do this for you.

To add and scan available Digital Audio Player media:
1. Start Composer ME and connect to Director.

2. Inthe Controller pane, click Add.

Tip: If you get a dialog box that states you cannot add media, make sure your Control4 Installer
or Dealer has identified your Controller for you.

3. Browse to the directory of music files that you want to add or scan.
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After the files have been added, the scan automatically starts. In a few moments, the media is
scanned and you will see a list of albums appear. You might see the On-Screen Navigator update
during this process also.

Tip: Another way to add files from a network share to a Controller is to go to the Windows Start
menu, and select Run. Type //<Controller's IP
Address>/media/audio/music/<Artists>/<Albums> and copy the files there.

4. Refresh your Navigators.

5. The media is now selectable for viewing from the Touch Screens, MyHome apps, On-Screen
Navigators, and System Remote Control.

Setting Up Media on a CD or Disc Changer

When setting up a Control4®Disc Changer (or CD Changer), you can add and scan media according
to the controls available on your Disc Changer. Adding and scanning populates the media information
to the Media Database, which lets you view the media from your Touch Screens, On-Screen
Navigators, MyHome apps, and System Remote Control.

Notes:

The AMG c4lookup service from previous releases has been changed to Gracenote® and Control4
has not implemented a Ul for browsing CDs stored in a Disc Changer in OS 2.0. Use an older
navigator (prior to OS 2.0) that supports this functionality if this is important to you.

Other Media Managers: You can use other media managers, for example, iTunes, Windows Media
player, and MediaMonkey to create MP3s. You can still use Composer ME and Composer HE to add
files to Control4.

THE SONY 777 DISC CHANGER USES GRACENOTE, BUT THE MEDIA CONTROLLER CAN NO LONGER ACCESS ALBUM, TITLE, OR ARTIST INFORMATION FROM AMG (THE PREVIOUS
LOOKUP SERVICE). CDS, HOWEVER, CAN BE IMPORTED AND WILL SHOW UP IN THE MEDIA DATABASE WITH A DATE AND TIME STAMP.

In the Media pane, if you select CD or Disc Changer, the following options are available. In some
cases, you select an entry and click a button, or just click one of these buttons (Search and Scan):

e Edit. Edit an entry's metadata (Title, Artist, Director, Genre, etc.).
e New DVD. Add new DVDs to the Media Database.

e New CD. Add new CDs to the Media Database.

e Delete. Delete an existing entry.

e Scan. Scan the media on your CD or Disc Changer to the Media Database (recommended if
available).

e Search. Search for media titles on your CD or Disc Changer in the Media Database.
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The following steps show how to add media to the Media Database using these options.

Prerequisites

Ensure that the CD or Disc Changer has been added and identified in the Control4 system. Your
Control4 Dealer or Installer can do this for you.

To scan media on a CD Changer to the Media Database:
1. Selectthe CD Changer in the Media pane.
2. Inthe Disc Changer pane (right pane), click Scan.

3. The scan results appear in the Discs pane. After you refresh your Navigators, you are ready to
play music.

To search media on a Disc Changer to add to the Media Database:
1. Inthe Disc Changer pane, click Search. The search dialog appears.

2. Type the DVD name in the blank box. For example, type 'A Beautiful Mind," and then click
Search. The 'DVD Title' matches appear in the Search Results window.

3. Use the scrollbar if necessary to find the appropriate DVD title.

4. Selectthe DVD title, drag it directly over the empty line item in the Disc Changer list, and then
select it.

5. Click Finished.

6. Repeat the previous steps for the DVDs/CDs in the Disc Changer that you want to add to the
Media Database.

7. Refresh your Navigators. The media you added is now available to view in the Navigators.
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To add and search using the New DVD or New CD options:

1. Select CD or Disc Changer in the Media pane.

2. Select an 'empty' line item for the New DVD and New CD buttons to appear.
3. Click either New DVD or New CD as appropriate.
4

The New Movie or New Album dialog appears. In the Title box, enter the DVD you want to play,
for example: 'A Beautiful Mind.'

5. Click Search.

New DVD:
New Movie [Z|
Movie | Cast and Synopsis
Title:
| | [ Search... I
Director Run Time:
| | |
Studio: Released
| || |
Genre: Rating
| | |
Location:
[ |
At
Copyright © 2012 Control4. All Rights Reserved.
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The following results appear:

| [Tite v [ seach |

Search Results
Title Autist Genre

%

Drama

Drama

Drama

Drama

R A Beautiful Mind (5] [Limited E dition] Drama

Drama

Drama

4

Select an entry to get detailed results:

Search E|
Title Art Cast
|A Beautiful Mind [P%5 Awards Edition] [2 Discs] | Russell Crowe; Jennifer Connelly; Ed Harmis; Paul
Bettany: Adam Goldberg: Judd Hirsch: Josh Lucas;
Director Anthany Fapp: Christopher Plummer; Austin Pendleton:
Jason Gray-Stanford; Vivien Cardone
|Rnn Howard |
Studio:
|DreamWorks |
Genre
|Drama |
Run Time: Released: Rating:
[128 | [20m | [Pa13
Synopsis

The true stom of prominent mathematician John Forbes Mash Jr. is the subject of this biographical drama from director Ron Howard, Russell
Crowe stars as the briliant but arrogant and conceited professor Nash. The prof seems guaranteed a rosy future in the early B0s after he
marries beautiful student Alicia [Jennifer Cannelly) and makes a remarkable advancement in the foundations of ''game theam,” which carries
him to the brink of intermational acclaim. Soon after, John is visited by &gent \wWiliam Parcher [Ed Harri], from the ClA, who wants to recruit
him for code-breaking activities. But evidence suggests that Mash's perceptions of reality are cloudy at best; he is struggling to maintain his
tenuous hold on sanity. and &licia suspects a diagnosis of paranoid schizophrenia, B attling decades of ilness with the loval Alicia by his side,
Mash iz ultimately able to gain some control over his mental state, and eventually goes o to tiumphantly win the Nobel Prize. Based loosely
on the baok of the same name by Sylvia Nasar, & Beautiful Mind [2001] co-stars Paul Bettany. Adam Goldbera. Anthony Rapp. Christopher
Plummer, and Judd Hirsch Karl wiliams, All Movie Guide

[C) 2005 All Media Guide, LLC
Cantent provided by All Music Guide(R), a trademark of All Media Guide, LLC

<Back | [_Finished | [ Cancel

New CD:
Similar results occur as with the New DVD option. Follow the same steps.
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New Album @

Album | Tracks | Notes
Name:
Artist:
Label: Year:

Genre:

At

Find &t File...

6. When the Search dialog appears, use the scrollbar if necessary to find the appropriate cover art,
and highlight it.

You can change the search criteria, and search again if necessary. The possible matches from
the Web database appear in the Search Results window (see above).

7. Click Next. You can choose which information to import, and edit any associated information
before adding the media to the Media Database (see screen above).

8. Click Finished.
9. Click OK.

10. Refresh your Navigators. The DVD is available to view in the CD or DVD pane and on the Touch
Screens, MyHome apps, and On-Screen Navigators.

Note: If no cover art is found in the file's metadata, then no cover art is associated with the music
unless the system is registered in 4Sight, and you can go to the online media lookup (Media view >
Edit > Name > Search > Select > Next) to obtain the cover art for your music. Check with your
Control4 Dealer or Installer for details.

4.2 Setting Up Videos for a Media Player

Your Control4® Dealer or Installer can help you get set up to play videos on your Control4 Media
Player. Your videos must already exist on a network-attached storage drive before they can be
scanned for the Media Player.

For information about scanning files for the Media Player, see the Control4 Media Player Installation
and Setup Guide or the Control4 Media Player User Guide.
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4.3 Auto-Scan Mediain Composer ME

This section applies to a Sony CX777ES Disc Changer.

The benefits of running a Control4® Disc Changer with bi-directional communications (RS-232), for
example, Sony CX777ES, is that you can scan your DVDs or CDs stored in the Disc Changer to
identify, index, and automatically apply cover art and media information. You can have your Control4
Dealer or Installer configure your Control4 system in Composer ME to scan media automatically, or
you can set a manual scan using the Scan button. The default is to scan media manually.

Notes:

1. If you scan a DVD or CD, and the media is not recognized, it will be titled “unknown.” You can edit
the DVD or CD's metadata and manually provide this information from either Composer ME or the
Navigators. If this DVD or CD is then changed to a different slot, the system will apply this same
information.

2. Because media scanning has been moved to the background, the scanning status is only
available through Director status messages. To do this, you can either watch the Director status
line or re-select the media to view the content that has been scanned.

3. Composer ME does not need to be open to scan media. This lets you use other media managers
(iTunes, Windows Media Player, etc.).

Prerequisites

Ensure that the devices you want to scan have been added and identified in the Control4 system.
Your Control4 Dealer or Installer can do this for you.

If you want to schedule regular scans, ensure that your network-attached storage is set up and is
accessible from Composer ME.

To schedule a regular scan of media from a network-attached device for a Media Player, for example:

1. From the Composer ME main screen, select Media Scanning Options. To scan your media now
(and not set up a scheduled scan), click Scan Now and skip the Scanning Schedule in Step 2.

2. Inthe Options pane, set the schedule as follows:
e Scanning Schedule. Select one.
e Never. Select if you never want to schedule an automatic scan.
e Every x Days or Weeks (up to 10). Select the frequency to scan.
e On the following days. Select Sunday through Saturday.

e At <time>. Use the up and down arrows to select the time. Highlight AM or PM and type
the value: AM or PM.

e Files To Scan. Select a device and extension.
e Network File Storage. Select if you have a NAS you want to scan.

e USB Drive. The manufacturer's USB drive appears here. Select if you have a USB drive
you want to scan.

e Extensions. Use the up and down arrows to choose the file type to add or remove. To
add a file extension (if it doesn't appear in the list), use the down arrow to select the
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extension, select Video or Audio, and then click Add. Click Remove to remove that file
type from the list.

e Use Online Media Lookup to improve scan results. Check if you don't want the search
to access the Internet for every format lookup, for example, a specific title or cover art.
Tip: Properly tagged files will result in must faster access.

e Remove media from the database if the files no longer exist. Check to remove
database information when a media file has been deleted. Be careful, however, because
if for example you disconnect a USB drive with media on it, the database files will delete
them if checked, and you may not want to delete them if you use the drive again.

e Update media database if file tags have changed. Check to have the database
updated if the metadata changes.

3. Click Apply.
4. Click Scan Now to start the scan immediately or Stop Scan if you've started the scan and want to
stop it.

4.4 Testing the Media Connection

To test control of media through the Control4® Navigators (System Remote Control, On-Screen
Navigator, MyHome apps, or Touch Screens), use the steps outlined in the Control4 System User
Guide.

Suggested test items:
e Play an album
e Add an album or track to the Now Playing queue
e Play a playlist created in Composer
e Create a playlist at a Navigator (for example, one of the Touch Screens)
e Play multiple streams of music (play different music in different rooms)
e Play a movie on the Television, DVD player, or Blu-ray player

4.5 Setting Up Media for Television Stations

Use the Control4® Composer ME Media view to set up a broadcast television station and listings for
display in the Navigators.

Prerequisites

Ensure that your television is added and identified in the Control4 system. Your Control4 Dealer or
Installer can help you do that.

To set up media for broadcast television channels:

1. Highlight UHF/VHF or another broadcast media type.

2. Click Search.

3. When the dialog appears, type your zip code in the box.
4

Click Search, and use the pull-down menu to select Local Broadcast Listings. The available
channels are populated according to the Search Results.

5. Check the boxes to select the desired channels that you want to appear on the Touch Screens,
MyHome apps, On-Screen Navigators, and System Remote Control.
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6. Click OK.
Search

Zip: 84020 Provider: ‘ NTSC [analog) Broadeoast - ‘

Search Results

MName Channel # Description Genre Rating Audio Only
WDYRLP 18 False
WDYRLP 22 False

[ kucwp 26 False
KBAGS 48 False

O ke 18 False
K52GL 50 False

[ k1 56 False
KUB=LP 53 False
KBEFN 66 False

The selected stations populate in the UHF/VHF pane. You can edit the information as needed;
add a description, genre, etc.

7. (Optional) To edit a channel, select the channel, and click Edit. The following dialog appears.
8. Edit the information and click OK.
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9. Refresh your Navigators. The media can now be selected to view in the Navigators.
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4.6 Setting Up Media for Radio Stations

Use the Control4® Composer ME Media view to set up radio station listings to display on the
Navigators.

Prerequisites

1. Ensure that your devices are added and identified in the Control4 system. Your Control4 Dealer
or Installer can do that for you.

2. Ensure that you have a Tuner in the system.

To set up media for radio stations:

1. Under Broadcast, select the radio type: AM Radio, FM Radio, or XM Radio.
2. Click Search.

3. When the dialog appears, type your zip code in the box.

4

Click Search again. Use the pull-down menu to select AM Broadcast Stations or FM Broadcast
Stations if applicable. The available stations are populated in the Search Results window.

5. Check the boxes to select the desired stations that you want to appear on the Touch Screens,
On-Screen Navigators, MyHome apps, and System Remote Control for that radio type.

6. Click OK.
s x|
Zip: | 84020 Provider | &M Broadcast Stations v
Search Results
Hame Channel # Description Genre FRating Audio Only L
KaLL 700 Ak Morth Salt Lake City, UT Sports True
O EANN 1120 &M Rop. UT Chiistian Conte... Tiue
Fl KBJA 1640 &M Sandy, UT Spanish True
KCPw/ 1010 AM Tocele, UT Public Radia True
KDVL 10E0 A4 South Salk Lake, UT Nostalgia Tue
O KETY 1450 Ak Provo, UT Religious Tiue
KFHZ 1320 &M Salt Lake City, UT Sports True
.| KHON 1480 &AM Spanish Fork, UT Religious True
KIas 1230 &M Murray, UT Sports True
O KEAT BE0 AM Salt Lake City, UT Country True
O KLLE 1510 &M WestJordan, UT Gospel Music True
.| KLO 1430 &AM Ogden, UT Talk True
O kMRl TEE0 AM ‘whest Walley City, UT Religious Tue
O EMTI E50 &M Manti, UT Country True
O khak 540 A1 Delta, UT Talk True
[1  ENRS 570 AM Salt Lake City, UT Talk. True
O koaL 750 Ak Price, UT Sports True
0 kovo 960 AM Pravo, UT Sparts True
[l KRRD TEO0 AM Centerville, UT Spanish True ¥

The selected stations display in the AM or FM Radio pane.
7. (Optional) To edit a station, select the station, and then click Edit.
8. Edit the information, and then click OK.
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9. Refresh your Navigators.

10. Repeat Steps 1-5 for each radio broadcast (AM, FM, XM) you want to set up. Set up each one
separately. The media is now ready to view in the Navigators for selection.

4.7 Setting Up Internet Radio

Note: Internet radio ONLY supports MP3 streaming radio stations.

Use the Control4® Composer Media view to add, view and select Internet radio stations that you can
play from Touch Screens, MyHome apps, or On-Screen Navigators.

Prerequisites

1. Ensure that the Controller is installed and identified as directed in the Controller's installation
guide.

2. Ensure that the Internet radio stations you add are in MP3 format. You'll need to create a new
form for each station you add.

To configure Internet radio:

1. Start Composer and connect to a Director.
2. Click the Media view.

3. From the Media list, click Internet Radio.
4. Inthe Internet Radio pane, click New.
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5. Fill out the form:

a. Name: Add the name of the station.
b. Description: Add a description that's meaningful.
c. Channel: Add the URL for the channel. Note: Locate the URL of the MP3 stream that starts

with http://...

d. Genre: Add a genre if appropriate.
e. Check Audio Only for listening.

f. Cover Art: If you'd like, you can copy the radio station art to your list. In a browser, go to the
link and click Images. Click Find Art File to locate an image, copy it to your clipboard and
then click Paste from Clipboard.

g. Click OK.
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6. Go to the Touch Screen, MyHome apps, or On-Screen Navigator and select the Listen > Station.

Note: If you have several sources, Internet Radio appears under Sources.

Using External Storage Devices

Access digital music from an external storage device attached to your Control4® system. External
storage devices include USB flash drives, USB external hard drives, or a PC’s hard drive located on
the home network. Set up your music according to the external storage device and networked file
storage as described here.

Note: When you remove the external drive (network, USB, etc.), the music is no longer available. To
access the music again, re-attach the external storage device, and refresh your Navigators.

Prerequisites

External storage devices must have media stored in unprotected MP3, AAC, or FLAC formats.

To attach and scan external storage devices using a USB connection:

1. Power on the external storage device.

2. The documentation for your Controller shows you how to attach the external hard drive to the
USB port. Check with your Dealer for details or to get a copy.

3. After connecting the external storage device, scan the music on the external device connected to
the Controller to make it available on the Control4 system. Highlight the Controller to which the
external device is connected.

4. Click the Media view.

o

In the view, select the external storage device.
6. Click Scan. When scanning, the media appears as it is located on the Controller.
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Note: You can add media from the external storage device when connected to the Controller,
however, Control4 recommends that you connect your external drive directly to the PC where you
want to copy media, and then attach it to the Controller for scanning.

To access and scan the network-shared storage devices:
1. Check with your Dealer to create a shared network drive.

Example: Using Windows XP to make a local C:/ Drive directory available on the network, right-
click the folder and select Sharing and Security. Click Share this folder.

2. Configure the username, password, and workgroup (or domain) for the network file share. This
information varies between types; contact your Control4 Dealer or Installer if you need help with
this information.

3. Highlight the Network File Storage object.
4. Click Add or Scan.

Setting Up Playlists
Use the Control4® Composer ME Media view to set up a playlist to play songs and albums from your
Touch Screens, MyHome apps, On-Screen Navigators, and System Remote Control.

Prerequisites

Ensure that the appropriate audio devices are added and identified on the Control4 system. Ensure
that you have scanned your media in the Digital Audio player. Your Control4 Dealer or Installer can
help you do this.

Playlists are designed exclusively for streaming media in Digital Audio. If you subscribe to the
Rhapsody® Music Service or another service, then Rhapsody playlists can be created using a
Navigator. Check the website for your music service or the music service's Technical Support for
details. In OS 2.0 and later, playlists can include CDs/DVDs, broadcast channels or stations, or
Internet stations, but they are a separate playlist from those in Rhapsody or your preferred music
service.

Note: To set up a Rhapsody subscription on behalf of the user or yourself, obtain a Rhapsody
account at http://www.control4.com/rhapsody, and then refer to the information found in the Control4
System User Guide.
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To create a playlist:
1. From the Media menu, select New Playlist.

2. A'New playlist appears. You can rename it now, or later you can right-click and select Rename
Playlist to change the name. Example: Change New to Frank’s Playlist.

3. Drag the list of songs to the playlist.

4. (Optional) Have your Control4 Dealer or Installer add any albums or songs you want to the
playlist. See Control4 System User Guide for details.

5. Create, edit and play songs from your playlists using your Touch Screens, MyHome apps, or On-
Screen Navigators.

To delete albums or songs from the playlist:
1. After you add the albums, select the playlist that contains the songs to delete.
2. Right-click on the songs you don't want in your playlist, and select Delete.

Tip: To remove multiple songs, press Shift, select the songs, and then right-click Delete.

4.10 Editing Media Information

Use the Control4® Composer ME Media view to edit CD or DVD media information. You can edit

media information also on the Touch Screens, MyHome apps, or On-Screen Navigators.

Prerequisites

Ensure that the appropriate media devices have been added and identified to the Control4 system.

Your Control4 Dealer or Installer can help you do this.

To edit CD information:

1. Inthe Media view, double-click the device on which you want to edit a CD, such as a CD
Changer, Disc Changer, Controller or Digital Audio.

2. Click the Edit button, or double-click the media under <Media> Title.

3. To edit and enter any changes, click the Album tab (for music), for example. Edit the information
in the boxes under Name, Artist, Label or Genre. Click the Tracks and Notes tabs to view and
edit Track Titles and Notes. Click Find Art File or Remove Art to change the cover art. When
finished, click OK.

4. Click one of the Search buttons next to the Name to search the database for similar entries.

5. To select a search result, select the album Title and double-click, or click Next. At the next
screen, view and edit the album information, including Name, Artist/Composer, Label, Genre,
Year, Art, and Notes.

6. Make your changes, and click Finished. To return to the previous screens, click Back.

To edit DVD information:

1. Inthe Media view, select the Disc Changer or DVD, and then select a movie.

2. Click the Edit button, or double-click the title under Discs.

3. Click the Movie tab. Edit the Title, Director, Studio, Genre, Run Time, Release date and Rating as
desired.
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4. Click the Cast and Synopsis tab. Click in the Cast and Synopsis boxes to make the desired
changes.

5. Click the Movie tab.
6. Click Search to search the database for other DVDs.

7. Double-click the desired DVD, and edit the information as desired according to the previous
steps.

8. When you are finished, click Finished.

Other Composer ME Tasks

Use the Control4® Composer ME to perform other media-related tasks (see the sections below).
e “Clearing a Media List”
e “Exporting a Media List”
e ‘“Importing a Media List”
e “Updating Composer ME”

Clearing a Media List

Use the Control4® Composer ME Media menu to clean out information (metadata) about albums and
songs.

Prerequisites

Ensure that media has been added and identified to the Control4 system. Your Control4 Dealer or
Installer can help you do that.

To clear a media list:
1. Select the device on which you want to clear the media information. Example: Digital Audio.

2. From the Media menu, select Clear Media List. This removes the information including the title,
Cover Art, and related information from the Media Database.

Note: This option does not remove the media files.

Exporting a Media List

Use the Control4® Composer ME Media menu to export a media list from your Media Database to
your PC.

Prerequisites

Ensure that the device to export to and the media have been added and identified in the Control4
system. Your Control4 Dealer or Installer can help you with that.

To export the Media List:
1. Select the device on which you want to export the Media List. Example: Digital Audio.
2. From the Media menu, select Export Media List.
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This saves a copy of the file that contains all the title art and information from the Media Database to
your PC.

IMPORTANT: This option moves the media files.

5.3 Importing a Media List

Use the Control4® Composer ME Media menu to import a media list from your PC to your Controller’s
Media Database.

Prerequisites

Ensure that the device to export to and the media have been added and identified to the Control4
system. Your Control4 Dealer or Installer can help you with that.

To import the Media List from your PC to the Media Database:
1. Select the device on which you want to import the Media List. Example: Digital Audio.
2. From the Media menu, select Import Media List.

This saves a copy of the file that contains all the title art and information from your PC to your
Controller's Media Database.

IMPORTANT: This option does not move the media files.

5.4 Updating Composer ME

Use Control4® Composer ME to update the software to a new version.

You can update three (3) ways:
1. Help menu

2. Windows Start menu

3. Runthe Composer ME install

Prerequisites
Ensure that Composer ME has been installed on your PC.

To update Composer ME:
1. Update according to these options.
e From the Help menu, select Check for Updates.

e From the Windows Start menu, select Start > All Programs > Control4 > Composer >
Update Composer.

¢ Run the installation.
2. Follow the on-screen instructions to complete the update.
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Glossary

4

4Sight: An Internet service that provides a connection to the Home-Automation System any time and
from any place worldwide.

A
AAC: Advanced Audio Coding. A successor to the MP3 format. A standard, lossy compression and
encoding scheme for digital audio. Touts better sound quality.
AV: Audio Video

C

CD: (Compact Disc) - An optical disc that stores digital data. This format is compatible with Control4
products.

Composer: The Control4 software used to design and define a Control4 Home-Automation System.

Composer Pro: Composer is used to set up and configure Control4 devices to communicate with
each other in a Home-Automation System.

connection: Binding or linking devices together in Composer so they can communicate with each
other.

contact: Contacts are generally used to monitor the status of something (door, window, water sensor,
etc.) and can be hooked up through a security panel or directly using a Control4 Controller or
Contact/Relay Extender. Contacts connected to a Control4 Controller or Contact/Relay Extender can
be configured either as NC (normally closed) or NO (normally open).

Control4 system: A Home-Automation System designed and developed by Control4.
Controller: The main device that makes Home Automation possible. There may be multiple

Controllers within a Control4 system. The Controller that runs Director is referred to as the Primary
Controller.

D

device: A component that requires a device driver; code that is used to allow the Control4 system to
work with that device.

device driver: Every device in the Control4 system needs a corresponding device driver to control
the device.

Digital Audio Player: Provides digital audio streaming capabilities from a Controller with hard disk
space for music and movies.

Director: Each Control4 Controller (such as a Home Controller HC-500) ships with pre-installed
Director software (Linux based) embedded in the device. The Director communicates with Control4
products and third-party products to enable Home Automation and interaction of individual devices.
Director runs the Control4 devices. Composer Pro is the software used to connect to and program a
system Director that resides on a Controller.

DVD: (Digital Versatile Disc) — A media format for video and data storage.
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E

Ethernet: Uses Ethernet category 5 (CAT5 or CAT5e) wiring to transfer data. Ethernet uses a star
network topology that allows multiple points to communicate to a single point. The Speaker Point®
devices and Touch Screens use Ethernet to communicate to the Control4 Controller.

F

file format: A format used by applications to store/read files.

FLAC: Supported by Control4 for software release 1.8, this is a free, open source, lossless audio
codec format that supports tagging, cover art and fast seeking. Audio is compressed with no loss in
quality.

H

home network: A network installed in the customer’s home that provides an Ethernet or wireless
connection so that Control4 devices can communicate with each other.

Home-Automation System: The Control4 system: a line of Home Automation products that
communicate with each other over Ethernet, WiFi, or ZigBee for a total Home Automation experience.

L
LCD: (Lighted Crystal Display) - A display used with some Control4 interfaces.
LCD Navigator: An LCD device used to control lighting, music, videos, etc., on an LCD screen.
List Navigator: A System Remote Control device uses a Navigator that lists the options.

M

Media Database: Media information is stored in the Media Database, which will permit users to view
the media from the Navigators.

metadata: The information that describes the media: title, cover art, artist, song or movie, genre, etc.
MP3: A music format that makes streaming audio available.

N

Navigator: A Control4 Navigator used with the Control4 system to control lights, music, videos, etc.
Navigator is software that the customer interacts with using a Universal Remote Control, On-Screen
Navigator, MyHome apps, or Touch Screen.

network-attached storage: A hard drive or network share drive that can be attached to the Control4
system and used to retrieve and play music and movies in the system.

O

On-Screen Device: Allows you to select the controller (Media Controller or Home Theater Controller)
in the room that controls the source for the on-screen display.

P

playlist: A list of songs compiled in a list. The list can be compiled by songwriter, album, song type, or
any combination.
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programming: A machine-readable artificial language used to express computations that can be
performed by a device.

project tree: A tree view in Composer where the project is layered by the larger branches (Home,
Office, etc.) and then the lower branches (floor, rooms, etc.), and finally to the leaf level (drivers).

R
Remote Director: Connects you to the home network while working in Composer from a remote
location.

S

scan: An electronic read of media for replay on Control4 devices.

switch: An extension of a router that adds more Ethernet ports to support additional devices or clients
on the local network.

System Remote Control: A Control4 System Remote Control is a universal solution that replaces
System Remote Control devices from other manufacturers, and includes programmable buttons. This
System Remote Control can access on-screen (Graphical) Navigators.

T

Touch Screen: A Touch Screen is a Home-Automation System Navigator that controls the home’s
lighting, music, videos, and other devices on the Home-Automation System.

)
USB: Universal Serial Bus) - A format used with USB sticks that plug in to a USB port on Control4
devices.

\

Virtual Connection: A term used in Composer Pro to indicate a connection outside the network.

Virtual Director: A connection to a virtual Controller only (a PC is the Director host rather than the
Controller). Projects created or edited here are benign until the saved project is loaded onto a
Controller.

w

WiFi: Uses bi-directional wireless technology to transfer data. WiFi (wireless fidelity) devices
“connect” to each other by transmitting and receiving signals on a specific frequency of the radio band
using a wireless access point. This technology uses the star network topology. WiFi uses high
bandwidth 802.11.

WMA: (Windows Media Audio) — Audio data compression technology developed at Microsoft; an
audio file format that competes with MP3.

Z

ZigBee: A wireless network that uses bi-directional wireless mesh network technology to transfer
messages from one device to another. Unlike a star network topology where devices can only send
messages to each other by sending them first to a single central device (which then delivers the
message to the recipient device), a mesh network topology allows the devices to forward messages
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from one device to another, thereby extending the effective range of the network. Uses low bandwidth
802.15.4. 250 devices are allowed per controller but Control4 recommends 125.

ZigBee Pro: The 1.1 version of ZigBee that provides improvements in standardization by: allowing
more interoperability with other Control4 devices, support for home automation profiles, and improves
the scalability of multiple ZigBee access points.
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4Store, 7

AAC, 13

AAC format, 8

Add Director, 14

Add new CD, 22

Add new DVD, 22

Album tab, 33

AM radio, add, 28
AM/FM/XM, 16

AMG, 8

AMG lookup, 15

Audio products, and ZigBee Pro, 8
Broadcast media, scan, 15
Broadcast television selection, 26
Cable TV, 16

CD, 15

CD Changer, scan media, 20
CD Changer, set up media, 19
CD, add new, 20, 23

CD, edit information, 33

Clear Media List, 17
Composer ME interface, 11
Composer ME, get started, 9
Composer ME, update, 35
Composer, close, 12
Composer, refresh Navigators, 12
Connect to Director, 14, 16
Contact Information, 2
Copyright, 2

Cover Art, find, 33

Cover Art, not found, 24
Create playlist, 33

Delete media, 20

Delete Playlist, 18

Delete songs from playlist, 33
Digital Audio, 15

Digital Audio player, 32

Direct TV, 16

Director, startup, 11

Directors dialog, 14

Disc Changer, 15

Disc Changer pane, 20

Disc Changer, set up media, 19
Disclaimer, 2

Disconnect from Director, 16
Discs pane, 20

Dish Network, 16

DVD, 15

DVD, add new, 20, 22

Composer ME User Guide

DVD, edit information, 33

Edit metadata, 20

Exit Composer, 12, 17

Export Media List, 17

Export Playlists, 17

File extension, add, 26

File menu, 16

File tags, 18

Find cover art, 33

FLAC, 13

Flash interface, 7

FM radio stations, add, 28
GNU, 2

Gracenote, 2

Gracenote lookup service, 15
Gracenote online media lookup service, 8
Hard disk requirements, 10
Hardware not supported, 7, 8
Hardware, and ZigBee Pro, 9
HDD, 16

Help menu, 16

Import DVD List from File, 17
Import Media List, 17

Import Playlists, 17
Installation, 10

Internet radio, setup, 16

10 Extender, 8

iTunes, 9

Legal Notice, 2

Local Broadcast Listings, 27
Media Auto-Scan, 25

Media Controller limitations, 15
Media database, 15

Media Database, scanning and adding to, 19
Media file tags, 18

Media list, clear, 34

Media list, export, 34

Media list, import, 35

Media menu, 16

Media Monkey, 9

Media pane, 19

Media Player, 24

Media Player, and NAS, 24
Media Player, scanning files, 24
Media scanning, status messages, 25
Media view, 14

Media, remove, 26

Memory requirements, 10
Menu options, 16
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Movie, add new, 22

MP3, 13

MPEG, 2

MR3, 9

Music, add new, 23
Network file storage, 16
Network requirements, 9
Network share, access, 32
New media, 7

New Playlist, 17

Playlist, create new, 33
Playlist, delete songs, 33
Processor requirements, 10
Purpose of document, 5
Radio stations, add, 28
Refresh Composer ME, 12
Refresh Director list, 14
Refresh Navigators, 17
Refresh screen, 16
Related Documents, 5
Remove media, 26
Rename Playlist, 18
Requirements, 9
Rhapsody, 32

Scan media, 14, 20

Scan Now, 26

Scanning
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iTunes, 25

Schedule, 25

USB drive, 25

Windows Media Player, 25
Search dialog, 24
Search Results window, 24
Software not supported, 7, 8
Software requirements, 9

Sony Disc Changer, auto-scan, 25

Start Composer ME, 10
Stop Scan, 26

Stored media, scan, 15
Test media, 26
UHF/VHF, 16, 26
UHF/VHF pane, 27

Unprotected format, media storage devices, 31

USB drive

scan, 25

using, 31
USB port, 31
Video requirements, 10
What's new, 6
Windows 7, 10
Windows Media Player, 9
Windows Vista, 10
Windows XP, 10
WMA, 13
WMA format, 8
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